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1. Wireless Sensor Network Overview

The LORD MicroStrain ® Wireless Sensor Network is a high- speed, scalable, sensor data
acquisition and sensor networking system.  Each system consists of wireless sensor interface
nodes, a data collection gateway, and full-featured user software platforms based on the LORD
MicroStrain® Lossless Extended Range Synchronized (LXRS®) data communications protocol. 
Bidirectional wireless communication between the node and gateway enables sensor data
collection and configuration. Gateways can be connected locally to a host computer or remotely via
local and mobile networks. Some gateways also feature analog outputs for porting sensor data
directly to standalone data acquisition equipment.

The selection of available nodes allows interface with many types of sensors, including
accelerometers, strain gauges, pressure transducers, load cells, torque and vibration sensors,
magnetometers, 4 to 20mA sensors, thermocouples, RTD sensors, soil moisture and humidity
sensors, inclinometers, and orientation and displacement sensors. Some nodes come with
integrated sensing devices such as accelerometers. System sampling capabilities are IEEE
802.15.4-compliant and include lossless synchronized sampling, continuous and periodic burst
sampling, and data logging. A single gateway can coordinatemany nodes of any type, andmultiple
gateways can be managed from one computer with the Node Commander® and SensorCloud™
software platforms. Integration to customer systems can be accomplished using OEM versions of
the sensor nodes and leveraging the LORD MicroStrain® data communications protocol.

Common wireless applications of LORD MicroStrain® Sensing Systems are strain sensor
measurement, accelerometer platforms, vibration monitoring, energy monitoring, environmental
monitoring, and temperaturemonitoring.
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2. Node Overview

The Torque-Link™-LXRS® strain gauge node is an application-specific node assembly used for
monitoring the torsional strain on a rotating shaft.  Torque-Link -LXRS assemblies are designed to
fit most shafts sizes and integrate with field-installed strain gauges. 

The Torque-Link -LXRS utilizes the SG-Link®-OEM wireless sensor technology to acquire and
distribute the strain gauge data.  The Torque-Link -LXRS has 16-bit resolution, can log data to
internal memory, transmit in real-time, and support event-driven triggers with both pre- and post-
event buffers. 

To acquire sensor data, the Torque-Link -LXRS is used with any LORD MicroStrain® LXRS® data
gateway such as the WSDA® -Base -10x -LXRS® and WSDA® -1500 - LXRS®, and either the
Node Commander® or SensorCloud™ software interfaces.  The Node Commander software is
included with the gateways and allows configuration of the node.

Figure 1 - Torque-Link™-LXRS® Torque Sensor
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2.1 Component List

The Torque-Link -LXRS comes with the components shown in Table 1 - Component List. The
standard assembly (Figure 2 - Assembly Components ) has one sensor channel, which
accommodates monitoring a full-bridge strain element array (see Installing Strain Gauges on
page 33). A two-channel assembly is also available for redundant or additional monitoring.

For a complete list of available parts and options, see Parts and Configurations on page 70.

Figure 2 - Assembly Components

Item Description Quantity

A Torque-Link™-LXRS®

(1 channel standard (shown) , 2 channel optional)
1

B Lithium battery pack (installed in assembly) 1

C Battery compartment screws - 4-40 x 5/16" 6

D Collar screws - 8-32 x 5/8" 4 or 6

-- Strain gauge connector 1

-- Strain gauge and wiring terminal kit (optional) 1

Table 1 - Component List
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2.2 Interface and Indicators

The Torque-Link -LXRS consists of two half collars. One half includes compartments for the
node electronics and battery pack, and cutouts for a strain gauge and wiring.  The electronics
compartment is potted at the factory tomake it suitable for harsh environments. The other half
simply has the cutouts for the strain gauge and wiring. In the optional two channel version of the
Torque-Link -LXRS , both haves have an electronics and battery compartment. For more
information see Parts and Configurations on page 70.

From the electronics compartment there are two connectors. One goes directly into the battery
compartment for connecting power, and the other is trained through the wiring channel to
connect to the strain gauges.

Figure 3 - Interface and Indicators
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The indicators on the Torque-Link™-LXRS® include a device status indicator that is visible
through a light-pipe next to the battery compartment

Indicator Behavior Node Status
Device
status
indicator

OFF Node is OFF

Rapid flashing on start-up Node is booting up

1 (slow) pulse per second Node is idle and waiting for a command

Table 1 - Indicator Behaviors

2.3 Assembly and Disassembly

The Torque- Link - LXRS contains an internal, non-
rechargeable Lithium battery. For important precautions see
Safety Information on page 80.

The Torque-Link -LXRS is disassembled for installation and service using a standard 9/64" hex
key. The battery compartment cover is removed with a T8 Torx (star) driver.

Figure 4 - Disassembly
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2.4 Node Operational Modes

Sensor nodes have three operational modes: active , sleep , and idle. When the node is
sampling, it is in active mode. To stop sampling, the node is put into idle mode. Idle mode is
used for configuring node settings (such as frequency and sampling rates) and is the only way
to stop sampling or go between active and sleep modes. Sleep mode is an ultra low-power
mode. The node will automatically go into sleep mode after a user- determined period of
inactivity. The node will not go into sleepmodewhile sampling.

Figure 5 - Node Operational Modes
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NOTE

The Torque-Link -LXRS is powered-on whenever the battery is connected. With no
activity, it goes into sleep mode and must be reactivated with an idle, wake, or stop
command to resume use.

2.5 On-board Temperature Sensor

l The Torque-Link -LXRS has an on-board, solid state temperature sensor mounted
on the surface of the circuit board.

l The temperature sensor output is connected to channel 3 of the Torque-Link -LXRS

l Refer to the node specification table for the temperature sensor operating
parameters (seeOperating Specifications on page 75).
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3. System Operational Overview

The Torque- Link - LXRS contains an internal, non-
rechargeable Lithium battery. For important precautions see
Safety Information on page 80.

To acquire sensor data, nodes are used with any LORD MicroStrain® data gateway, such as the
WSDA® -Base -10x -LXRS® or WSDA® -1500 - LXRS®, and a software interface.

LORD MicroStrain® has two software programs available for data acquisition from the wireless
sensor network: SensorCloud™ and Node Commander®.  SensorCloud™ is an optional web-
based data collection, visualization, analysis, and remote management platform based on cloud
computing technology. Node Commander® is used for configuring gateways and nodes, selecting
samplingmodes and parameters, initializing data acquisition, and viewing and saving data.

The operational overview describes system hardware and software setup, and the basic
navigation of Node Commander® used to configure the node and begin data acquisition.  A brief
overview of porting data to SensorCloud™ is also included. This section is included as a quick start
guide and is not a complete demonstration of all system and software capabilities.

3.1 Software Installation

To install Node Commander ® Software Suite  on the host computer, run the installer
executable file and follow the on-screen prompts. The software is provided with all gateways
and is also available on the LORD MicroStrain®website (see References on page 82).

The suite includes the following programs:

l Node Commander is used for configuring nodes and acquiring, viewing, and
saving data. 

l Live Connect™ is a TCP/IP-to-serial conversion tool that translates the
communications between Node Commander and an Ethernet gateway.

l WSDA® Data Downloader is used to download acquired data to a host computer
from the flashmemory card embedded in an applicable gateway.

SensorCloud™ is an optional data collection, visualization, analysis, and remote
management tool. It is based on cloud computing technology and is accessed directly from a
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web connection. Automatic, real- time data collection is available through Ethernet
gateways, such as the WSDA® -1500 - LXRS®. Data files can also be uploaded. For more
information see Data Handling on page 28.

Users can also design custom programs with the open source data communications
protocol (see References on page 82).



Torque-Link™-LXRS® Torque SensorUserManual System Operational Overview

15

3.2 System Connections

To acquire sensor data the following components are needed in addition to the node: strain
gauges and application materials, a LORD MicroStrain® data gateway, and a host computer
with access to the data acquisition software. For a connections overview refer to Figure 6 -
SystemConnections .

Nodes will communicate with any LORD MicroStrain® data gateway. The sensor, node,
gateway, and software selection are application-dependent, but the basic interfaces are the
same. Communication protocols between the gateway and host computer vary depending on
whichmodel gateway is used, but they all require interface to a host computer or network.  The
WSDA® -Base -10x -LXRS® gateway utilizes local serial connections to the host computer,
such asRS232 and USB, and interfaceswith the Node Commander® software. TheWSDA® -
1500 - LXRS® gateway utilizes Ethernet communications and can be used with Node
Commander® and SensorCloud™, although system configuration is completed using Node
Commander®. Gateways with analog outputs can be connected directly to stand-alone data
acquisition devices for data collection, however system configuration will still occur through a
USB interface to Node Commander®.

Users can also write custom programs by utilizing the LORD MicroStrain®Wireless Sensors
Network Software Development Kit (see References on page 82).

Figure 6 - System Connections
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3.3 Gateway USB Communication

TheWSDA-Base USB gateway is used as an example in this quick start guide. For information
on how to use other gateways, refer to the gateway or Node Commander® user manual (see
References on page 82).

Drivers for the USB gateways are included the Node Commander® software installation. With
the software is installed, the USB gateway will be detected automatically whenever the
gateway is plugged in.

1. Power is applied to the gateway through the USB connection. Verify the gateway
status indicator is illuminated, showing the gateway is connected and powered on.

2. Open the Node Commander software.

3. The gateway should appear in the Controller window automatically with a
communication port assignment (Figure 7 - USB GatewayCommunication). If it is not
automatically discovered, verify the port is active on the host computer, and then
remove and re-insert the USB connector.

Figure 7 - USB Gateway Communication
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3.4 Connect to Nodes

Several methods can be used in Node Commander® to establish communication with the
nodes. This quick start section covers the two simplest methods; adding a node by address and
by using the node discovery feature.

NOTE

If the Torque-Link™-LXRS® has the two-channel option, each will be accessed as
separate nodeswith unique addresses in Node Commander.

3.4.1 Adding a Node by Address

Adding a node by address requires the node to be on the same communication frequency
as the gateway. The node address and frequency are indicated in the documentation
included with the node when it is purchased.

1. To add a node by address, right-click on the gateway name in the Controller window,
and select Add Node > Add Single Node (Figure 8 - Adding a Node by Address).

2. The node address and frequency are indicated in the documentation included with
the node. Enter the node address, and select OK. If the node is not found, amessage
will appear and provide the option to scan for the node on other frequencies.
Alternately, the Node Discovery feature can be used.

Figure 8 - Adding a Node by Address
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3.4.2 Using Node Discovery

The Node Discovery feature allows connection between the gateway and node to occur
even if they are on different frequencies.

NOTE

Automatic node discoverymay not work in some boot-up modes. If the node is
not in normal boot upmode, the assigned one can be bypassed to enable node
discovery. For more information see Troubleshooting Guide on page 57.

1. To connect to all available nodes using node discovery, begin by making sure the
node power is off. Right-click on the gateway name and select Add Node > Node
Discovery (Figure 9 - Using Node Discovery).

2. Turn the node power on. Within a few seconds, the node will transmit a message with
its operating frequency.

3. When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one-second intervals, the node has completed the normal boot-up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window; scanning can be stopped by selecting the Stop button in the Node
Discovery window.

Figure 9 - Using Node Discovery



Torque-Link™-LXRS® Torque SensorUserManual System Operational Overview

19

3.5 Channel Configuration

Each sensor is assigned a channel number. The sensor settings are stored in the nodememory
for that channel. The configuration menus only show the channels and configuration options
available for the type of node being used.

1. To enter the configurationmenu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the node.

a. Channel Enabled: indicates the sensor channel number. The check box
is used to enable the channel and select it for sampling. The icon next to
the check box describes the channel type inherent to the node being used.
(Figure 10 - Node ChannelsMenu)

b. Current channel configuration: The Data Output, Units, Input Range,
and Label fields describe how the channel is currently configured.

c. Configure: TheConfigure button changes the channel parameters, such
as measurement units, gain and offset settings, and calibration
values. The channel must be enabled first by selecting the adjacent check
box.

Figure 10 - Node Channels Menu
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2. To enter the channel configuration menu, select the Configure button as shown in
Figure 10 - Node Channels Menu. The channel configuration menu options change
depending on the sensor type selected.

a. Channel Label: names the channel

b. Channel diagram: shows channel electronics and data flow

c. Conversion Coefficients: defines the type and units of the
measurement beingmade

d. PGA Settings: determines what gain is applied to the sensor
measurement and set the position of the no-load baseline measurement
for the sensor signal. It is only available for differential input channels with
gain amplifiers.

e. Calibration values: includes the slope, offset, scale, and formula used to
convert the sensor reading to engineering units. The slope and offset can
be determined from the sensor manufacturer calibration data or through a
calibration process.

Figure 11 - Channel Setup
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3.6 Sensor Calibration

NOTE

Strain gauge calibration is required for any new strain element that is attached to a
node. Calibration converts the strain gauge voltage output to engineering units, and
accounts for the slight variations between strain elements, wiring, nodes, and
operating conditions. Calibration can be completed by performing an internal or
external shunt calibration through Node Commander. For more information and
instructions, see Strain Gauge Calibration on page 42.
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3.7 Sampling Settings

Sampling settings are accessed through the Configure Node menu. There is a tab for each
sampling mode available for the particular node (Figure 12 - Sample Settings Menu ).The
Torque-Link -LXRS has four primary sampling modes: Synchronized Sampling, Low Duty
Cycle Sampling, Streaming, and Datalogging. Some modes have user-configurable settings
for sample rate, sample duration, and datalogging. Other settings are automatic, depending on
number of active channels and other variables. For more information on samplingmodes, refer
to the Node Commander user manual (see References on page 82).

Figure 12 - Sample Settings Menu

In general, when determining what sample mode and rate is most suitable for the application,
refer to the following guidelines;

l Use a sample rate at least twice the value of the target measurement frequency. This is the
minimum sample rate required to produce an accurate digital representation of the
measured signal. The higher the sample rate, themore accurate the digital representation.

l Using the minimum required sample rate will increase battery life and minimize the
allocated network bandwidth.

l Using periodic burst sampling in place of continuous sampling will increase battery life. The
longer the sample interval, themore power and network bandwidth will be saved.

For synchronized sampling, use the online calculator to evaluate network bandwidth at different
sampling settings :

http://www.microstrain.com/configure-your-system

http://www.microstrain.com/configure-your-system
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3.8 Data Acquisition

When data acquisition is started, each of the sampling modes has different menu options and
views. Some open a settings menu before data acquisition begins and may include a data list
view and/or a graph view. For more information about synchronized sampling and using the
gateway beacon see Data Acquisition on page 23. For more information about other sampling
modes, refer to the Node Commander user manual. (see References on page 82).

To start a sampling session, nodes can be selected individually or as a group. When selected
as a group, theywill all be set to the same sampling mode. Right-click on the nodes, and select
Sample > Synchronized Sampling.

Figure 13 - Starting a Sampling Session

When a synchronized sampling session is started, the sampling menu appears and includes
settings to enable optional sampling features, configure nodes, and to specify where the data
will be saved. The built-in bandwidth calculator displays the total bandwidth used by the nodes
selected for synchronized sampling (Figure 14 - Synchronized SamplingMenu).

a. Save Location: indicates where the data file will be saved on the host computer.
Use the Browse button to select a location.

b. Node configuration: includes the node serial number, sampling settings,
bandwidth calculation, and current status. Highlight any node or group of nodes,
and the Remove, Configure, and Refresh buttons become active. The Configure
button opens the node configuration menus to adjust settings as needed and
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recalculates the node bandwidth. Multiple nodes can be configured together by
using the Shift or Ctrl key to select them.

c. Lossless: enables the lossless data protocol. The protocol enables buffering and
retransmission of data in order to provide 100% data collection success. Using this
featuremay increase data display latency.

Figure 14 - Synchronized Sampling Menu

d. High Capacity: optimizes bandwidth and power use for nodeswith slower sample
rates by reducing the transmit rates. It may increase data latency.

e. Network Bandwidth: is the total calculated bandwidth used by all the nodes. The
bandwidth changes as nodes are added, removed, and as the settings are
changed.

f. Enable Beacon on Start:When synchronized sampling is started the nodes wait
for the first beacon transmission to initiate sampling. When this option is selected
(default), the gateway beacon is enabled and will begin transmitting at a fixed
interval when sampling is started. Disabling the beacon on start (unchecking the
box) will set the nodes to wait for the beacon, but it does not actually start the
beacon when sampling is started. This can be used if there is a need for sampling to
be initiated later, or if the beacon is being received from another source than the
gateway. Enabling the beacon in this way is the same as enabling the beacon in the
gatewaymenuRefer to the Node Commander®User Manual for more information.



Torque-Link™-LXRS® Torque SensorUserManual System Operational Overview

25

g. Apply settings and start sampling: Before acquisition can begin, use the Apply
Network Settings to save the session settings to the node. When completed, select
Start Sampling to begin.

h. Close sampling window (with the red "X") to exit sampling or, once the sampling
has started, to view the data window behind it.

NOTE

Once sampling has started it will continue as configured without the need to leave
Node Commander open. However, if the node is powered off and is not configured to
sample on boot-up, data acquisition will end andmust be restarted.
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Synchronized sampling features two data views: Grid view and Graph view. Once sampling
has started, the grid view is the default view (Figure 15 - Synchronized Sampling Data View).

Figure 15 - Synchronized Sampling Data View

a. Device status: Node sampling mode and gateway status are displayed in
parentheses next to the device name.

b. Node information: includes node serial number and sampling statistics. Right-
click on the node name for moremenu options such as Stop Nodes.

c. Data: is a display of the sampled data with each channel in its own column.

d. Radio strength: indicates the strength of the communication between the gateway
and node.SeeRange Test on page 64.

e. Data file: is the location and size of the data file, as data is added. View the data in
.CSV format with the Open File button.

f. View menu: Allows user to toggle between Data Grid andGraph views.

g. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.

NOTE

When synchronized sampling is set to slower sample rates it may take several
seconds after sampling is initiated for the first sample to appear.



Torque-Link™-LXRS® Torque SensorUserManual System Operational Overview

27

Use the view menu to select the Graph view of the data (see Synchronized Sampling Graph
View on page 27). Click on the node name to view the graph for that node. Click again to hide it.

Figure 16 - Synchronized Sampling Graph View

a. Available Nodes: Click on the node to display the graph for that node. Click again
to hide it. Right-click on the node name for more menu options such as Stop Nodes
and Save Stream.

b. Axis range: Select the x-axis width and y-axis zoom percentage, or use the Auto
check box for automatic scaling.

c. Graph: The node graph shows the sampled data. Each active channel is displayed
in a different color. The x-axis is time in seconds and the y-axis is the A/D value
(bits). Right-click on the graph for additional menu options such as View Graph Key,
Pan, Zoom, Pause, and RemoveGraph.

d. View menu: Allows user to toggle between Data Grid andGraph views.

e. Data file: The location and size of the data file as data is added. View the data in
.CSV format with the Open File button.

f. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.
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3.9 Data Handling

Data acquired through Node Commander® is automatically saved on the host computer (see
Sensor Data Files on page 32) and can also be viewed from the web-based SensorCloud™
portal. Saved data can be uploaded to SensorCloud™ and Ethernet gateways provide the
option to automatically port the data to SensorCloud™ during data acquisition for near real-
time display and aggregation. Ethernet gateways can also be configured to save data locally to
internal memory for future upload to the host computer or SensorCloud™.

SensorCloud™ is based on cloud computing technology and is designed for long term
collecting and preservation of data. Features include time series and visualization graphing,
automated alerts, and data interpretation tools such as data filtering, statistical analysis, and
advanced algorithm development with the integrated MathEngine® interface. Leveraging the
open source API, SensorCloud™ can also be used to collect data from other LORD
MicroStrain® sensor products or third- party systems. Basic SensorCloud™ services are
available to all users free of charge (see Connecting to SensorCloud™ on page 29).

Figure 17 - Data Storage, Display and Processing
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3.9.1 Connecting to SensorCloud™

To connect to SensorCloud go to the SensorCloud website log-in page, and enter the log-in
credentials. Register as a new user if needed.

http://sensorcloud.com/log-in/

Figure 18 - SensorCloud™ Log-in or Register

The SensorCloud interface has six main views. When logging in as a registered user, the
Device view is the default. Navigate to other views by clicking the view name at the top of the
page (Figure 19 - SensorCloud™ Menu Views). The Data and Settings views are only
available once a device is selected from the device list.

Figure 19 - SensorCloud™ Menu Views

http://sensorcloud.com/login/
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Device - The device list shows every Ethernet gateway and API device associated with the
SensorCloud account, including owned, shared, and demo devices. This view provides links to
each device’s SensorCloud subscription plan, configuration options, and a summary of last
communications and data transactions.

Account - The account view is for logistic management of the SensorCloud account, such as
changing the log-in password, accessing user email, and reviewing billing information.

CSV Uploader - The data upload feature enables data from any source (such as non-Ethernet
LORD MicroStrain gateways, or third- party sensor) to be uploaded to the SensorCloud
platform. The datamust be in the LORD MicroStrain CSV format.

Data - This view is only available after a device is selected. It displays data that is collected
from sensor nodes or uploaded from files. Data selections are listed by node channel or a user-
defined label and can be enabled for display in the graph window. The interactive graph has
navigational features such as panning, zooming, and an overview graph for single-click access
to data points or ranges. There are also use and management features such as viewing the
meta-data and downloading, embedding, and tagging data graphs.

Figure 20 - SensorCloud™ Data View

Settings - The settings view provides options for adding meta-data, configuring the data
displays for each channel, creating alerts based on data thresholds, setting the data timezone,
andmore.

MathEngine® - is used to analyze sensor data. Functions include the ability to filter out
frequencies, smooth out noisy data, performmath operations such as Fast Fourier Transforms
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(FFTs), and more (Figure 21 - MathEngine® View ) . MathEngine® interfaces with the
SensorCloud graphing view for faster processing. Users can write their own algorithms for
custom applications. Refer to theMathEngine®website for more information.

http://sensorcloud.com/mathengine

Figure 21 - MathEngine® View

Figure 22 - FFT Graph in SensorCloud™

For more information about SensorCloud features and navigation, refer to the SensorCloud
website or contact LORD MicroStrain Technical Support. 

http://sensorcloud.com

http://sensorcloud.com/mathengine
http://sensorcloud.com/mathengine
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3.9.2 Sensor Data Files

Data acquired in Node Commander is stored in .CSV format and can be opened with
Microsoft Excel, Quattro Pro, Open Office, or another CSV editor/spreadsheet program. 
Data in this format is easily uploaded to SensorCloud™ using the CSV Uploader. The data
files can be found on the host computer in the default directory or the location specified . The
files are organized in separate folders by mode and then further categorized by date,
session, and/or node serial number. 

The default directory is:C:\ProgramData\Microstrain\NodeCommander\Data

Synchronized sampling and low duty cycle files are found in the Sampled Data folder,
and streaming data is stored in the Streaming folder. Datalogging files need to be
downloaded from the node to be available for viewing. They are accessed through
datalogging menus as well as the File menu, and are saved in the Downloaded Triggers
folder.

Figure 23 - Exploring Data

NOTE

The Microsoft Excel the Time data column in the data file may have to be
changed to "m/d/yyyy h:mm:ss:000" format to make it more readable.
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4. Installing Strain Gauges

The Torque-Link™-LXRS® wireless node is designed for use with differential input sensors in a
Wheatstone Bridge configuration. The node provides a 3 V excitation voltage, signal processing,
and programmable gain settings (see Node Differential Inputs on page 33).

Full-bridge configuration with 1000 ohm strain gauges is recommended for torquemonitoring with
the Torque-Link -LXRS (see Wheatstone Bridge Tutorial on page 34). The Torque-Link -LXRS
can be ordered with two input channels for redundant or additional measurements. For available
options see Parts and Configurations on page 70.

4.1 Node Differential Inputs

The differential measurement channels provide a 3 V dc excitation voltage to the sensor and
measure the resulting sensor signal output.  The sensor signal goes through a programmable
gain amplifier (PGA) and is then processed in the node by a16-bit analog-to-digital (A/D)
converter over the 3 V dc range.  The resolution of the sensor measurement is dependent on
the operating range of the sensor.  If the application is such that only a small portion of the 3 V
dc range is being utilized, better resolution can be achieved by increasing signal amplification
and by zeroing the sensor baseline in the appropriate offset biasing range. Sensor gain and
offset values are configurable in Node Commander® (see Channel Configuration on page 19).

Figure 24 - Differential Channel Signal Processing
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4.2 Wheatstone Bridge Tutorial

TheWheatstone bridge is a series-parallel array of four resistors used tomeasure an unknown
resistance value. It is especially suited for measuring small changes. An excitation voltage
(Vex) is applied across the two parallel sets of series resistors, and the resulting voltage
measured across the adjacent series resistors (Vo) (Figure 25 - Wheatstone Bridge).

Figure 25 - Wheatstone Bridge

TheWheatstone bridge is the basis for all strain gauge configurations. Tomeasure strain, one,
two, or four of these resistors are replaced by strain gauges, which are functionally just variable
resistors. Replacing one resistor with a strain gauge is referred to as a quarter- bridge
configuration, replacing two resistors is half- bridge configuration, and replacing all four
resistors is a full-bridge configuration (Figure 26 - Full Bridge Wiring) . In all configurations,
strain gauges, and the circuits they interface with, are designed for use with specific circuit
impedance values andmust be selected accordingly. Common values are 350 or 1000 ohms.

Figure 26 - Full Bridge Wiring



Torque-Link™-LXRS® Torque SensorUserManual Installing Strain Gauges

35

The physical placement and orientation of the gauge elements on the object being measured
determines what type of strain measurement is achieved. Axial strain, shear strain, and
bending strain are three common measurements and represent the axis or direction of the
strain on the object. Placing the gauges in a parallel orientation with each other, in adjacent
orientation, or in some combination determines the measurement type (Figure 27 - Example
Gauge Placement).

Figure 27 - Example Gauge Placement

In addition to the actual strain changes, resistance changes in the Wheatstone bridge circuit
can also be caused by environmental factors such as temperature fluctuations. Strain in any
direction will also cause slight changes in the resistance value of a strain gauge regardless of
the gauge orientation. When using a quarter- bridge configuration this is a source of false
readings. However, the half-bridge and full-bridge configurations are capable of rejecting off-
axis strain when applied correctly. The full-bridge configuration has the added benefit that it
effectivly doubles the relative change in resistance (when compared to the half- bridge
configuration), whch results in higher accuracy. For these reason, full-bridge configurations are
recommended for measuring torque or axial strain with the Torque-Link -LXRS.
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4.3 Strain Gauge Installation

This section describes the recommend strain gauge placement and bridge configuration for
torquemeasurements with the Torque-Link-LXRSWireless Torque Sensor. 

NOTE

For accurate torque data, strain gauge installation must be completed in compliance
with strain gauge manufacturer recommendations and industry standard processes
for installing strain gauges such as ASTM E1237-93, Standard Guide for Installing
Bonded Resistance Strain Gauges .  Failure to properly attach and connect the
gaugeswill result in erroneous data.

4.3.1 Tools and Equipment

The following are required for installation of the Torque-Link -LXRS sensor node:

l 9/64 hex key

l Medium strength thread-locker (such as Loctite 425 or equivalent)

l Strain gauges and installation tools, as recommended by the strain gaugemanufacturer

o (4x) 1K ohm strain gauges (or two dual element gauges) and a wiring
terminal strip (for recommendations see Parts and Configurations on
page 70)

o gauge fastening and coating compounds

o strain gauge wire and applicable wire cutting and stripping tools

l Soldering iron and solder

l Standard wrench that will fit on the shaft (for field calibration only)

l Torque wrench (for collar screws and field calibration, if applicable)

l Safety glasses
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4.3.2 Strain Gauge Placement

When installing the strain gauges on the shaft, the primary considerations are the
orientation of the gauges, and the position of the gauges relative to the Torque-Link -LXRS
assembly and the cutouts for the gauges and wiring.

For torque measurement, the phenomenon being measured is shearing of the shaft
surface. Tomeasure this shear, the gauges should be installed at a 45° angle from the shaft
center-line (Figure 28 - Placement for Full Bridge Torque Measurements). Strain gauges
are available in dual- element shear gauge configurations already angled at 45°, which
makes this installationmuch easier.See Parts and Configurations on page 70 for suggested
strain gauges. The gauges are installed 180° from one another to maximize bending
rejection. It is recommended that a strain gauge wiring terminal be used halfway in-between
the two gauges for ease of wiring and to keep the strain element wires the same length,
which is a best-practice for signal integrity.

Figure 28 - Placement for Full Bridge Torque Measurements
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The inner circumference of the Torque-Link -LXRS assembly has recessed channels for the
gauge wiring between the electronics compartment and gauge pocket (Figure 29 - Strain
Gauge Placement).  Gauges, terminals, and wiring are installed so that they are completely
contained within the cutouts when the Torque-Link -LXRS is installed.  Check-fit the assembly
over the gauges during the gauge installation process to ensure proper clearance (see Torque-
Link -LXRS Installation on page 40). The connectors between the strain gauges and node
electronics will be tucked into the strain gauge pocket during final assembly.

Figure 29 - Strain Gauge Placement
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4.3.3 Strain Gauge Wiring

Once the strain gauges and wiring terminal are installed on the shaft in the desired location,
they are wired to a connector that mates to the node connector. The strain gauge wires and
the connector wires will then be attached to the wiring terminal. The connector is included
with the node or can be ordered separately (see Parts and Configurations on page 70).

The wires are soldered on to the strain gauge terminals in accordance with the strain gauge
manufacturers signal designations. For the connector wiring, refer to Table 2 - Strain Gauge
Wiring. It is best practice to keep the wires as short as possible and the same length as each
other to avoid influencing sensitivemeasurement. Once connected to the Torque-Link -
LXRS, the connectors will be tucked inside the gauge pocket. Wiring is shown for dual-
element full-bridge configuration (seeWheatstone Bridge Tutorial on page 34).

Connector pin Signal Wire color Strain element
3 V+ red R1 & R4

5 S+ yellow element 2 center

6 S- green element 1 center

1 GND black R2 & R3

Table 2 - Strain Gauge Wiring
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5. Torque-Link -LXRS Installation

5.1 Mounting the Assembly

The Torque-Link™-LXRS® is mounted on the shaft with the cutouts aligning over the gauges
and wiring.

Figure 30 - Assembly Installation

1. Disassemble the collar into the two halves, if not already done. Remove the collar
screws completely.

2. Peel the backing off the collar placement tape (two places, see Interface and
Indicators on page 9).

3. Place one half of the collar over the shaft, carefully aligning the gauge cutout (see
Interface and Indicators on page 9) over the gauge element, and wiring channels
over the terminal strip and wiring.Connect the strain gauge connector to the
electronic compartment connector, and tuck them into the strain gauge pocket.
Train the wiring into the wiring channel.

4. Press the first half of the collar on the shaft to temporarily stick it there with the
tape.
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5. Align the second half of the collar over the other gauge element and wiring, and
mate it to the collar screw holes on themounted half. 

6. Press the second collar half onto the shaft to stick it to the shaft with the tape.

7. Apply the thread locker on the collar screws, and fasten the two halves together,
ensuring no wires are pinched. Fasten snugly with 5 inch-pounds of torque. Do not
over-tighten. There should be a small gap (equal on both sides) between the collar
halves (Figure 30 - Assembly Installation).

5.2 Re-Using the Assembly

The Torque-Link -LXRS assembly can be re-used on other shaft assemblies as long as the
shaft is the same size. Use new collar placement tape for the new installation (see Parts and
Configurations on page 70 ). New installations or new strain gauges will need to be re-
calibrated after installation.



Torque-Link™-LXRS® Torque SensorUserManual Strain Gauge Calibration

42

6. Strain Gauge Calibration

Before the Torque-Link -LXRScan be used to acquire torque data, the strain gauges must
balanced through a shunt calibration. Additionally, conversion values can be determined to scale
the strain gauge output to engineering units.

Performing a shunt calibration in Node Commandercompletes both steps and automatically
populates the slope and offset values in the data acquisition formula used for converting the strain
gauge output to strain units (see Example Shunt Calibration on page 43.

If torque units are desired, a field calibration can be performed after the shunt calibration to
determine those conversion values ( see Example Lab or Field Calibration on page 48 ) .
Alternatively a theoretical torque formula can be used to convert the strain readings to torque(see
Theoretical Torque Formula on page 54).

The field calibration requires calculation of the calibration slope and offset values, and manual
entry into Node Commander®. When completing the calculation, the applied loads can either be
entered as strain values or torque values depending on how they were measured during the
calibration. Either way, Node Commander® assumes a linear relationship using the formula y =
mx + b. The calculation can be done using a simple graphing program such as Microsoft Excel
(see Calculating a Linear Slope on page 52).

The relationship between strain is not exactly linear, but may be accurate enough for many
applications. If more precision is desired, the calibration slope and offset calculation can be done
using strain, and then converted from strain to torque using the theoretical torque formula.

NOTE

Strain gauge calibration is required for any new strain element that is attached to a
node. Calibration converts the strain gauge voltage output to engineering units, and
accounts for the slight variations between strain elements, wiring, nodes, and
operating conditions.
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6.1 Example Shunt Calibration

1. Open Node Commander® and establish communication with the gateway and node.
(See SystemOperational Overview on page 13).

2. Right-click on the node name, and select Configure > Configure Node.

3. Select the check-box for Channel 1, which is where the strain gauge is connected,
and then select Configure.

Figure 31 - Node Configuration Menu
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4. Use the following settings;

a. Conversion Coefficients, Class: Strain

b. Conversion Coefficients, Units: µStrain

c. PGA Settings, Hardware Gain: 20

d. PGA Setting:Midscale (for positive and negative going signals)

5. Select the Auto Balance button to tare the no-load value of the strain gauge. Observe
the value returned for the Auto Balance value.

Figure 32 - Channel Settings
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6. Select the StrainWizard.

7. Select Internal or External calibration. An internal calibration uses a shunt resistor
inside the Torque-Link -LXRS to apply a fixed load on the strain input. An external
calibration uses a user-installed shunt resistor attached to the input.

8. Select the appropriate Bridge Type, and click Next.

9. Select Use the Strain MeasurementWizard and click Next.

10. Set the following parameters:

a. Number of Active Gauges: number of strain elements connected (for
example: 4 for a full-bridge, and 2 for a half-bridge)

b. Gauge Factor: ratio of mechanical strain to electrical output (a gauge
specification).

c. Gauge Resistance: the strain gauge ohm value (a gauge specification).

d. Shunt Resistance: 499000 ohms (if using the internal shunt resistor)

Figure 33 - Strain Wizard Settings
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11. Select Calibrate.

12. Verify the calibration looks as shown in Figure 34 - Strain Gauge Calibration.  The
green line represents the output of the strain gauge. With no load applied it should sit
near the Auto Balance baseline value, represented by the red dashed line.  During
calibration, a shunt resistance (selected on the Parameters page) is applied across
the strain bridge, shown by the square pulse on the output.  The Offset value, shown
with the dashed blue line, is the average output value of the pulse and should sit
across the top of the pulse.  If the gauge has not had to time to equilibrate before
sampling, or if varying environmental factors exist, spikes in the gauge output may
occur and affect the Baseline and Offset values.  If this occurs, the Baseline and
Offset values can be adjusted to clip the spikes in the output values.  Adjust them as
needed, and select Accept when completed. 

Figure 34 - Strain Gauge Calibration
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13. Select Finish to end the Strain Wizard.  Note that the slope and offset values have
been calculated automatically. 

Figure 35 - Completed Strain Wizard

14. Select OK to exit the Channel Configuration window.

15. In the Node Configuration window, select Apply to write the configuration and
calibration values to the node.

16. Select OK to exit.

Figure 36 - Apply Node Settings
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6.2 Example Lab or Field Calibration

1. Open Node Commander®, and establish communication with the gateway and node
(see SystemOperational Overview on page 13).

2. Right-click on the node heading, and select Configure > Configure Node. Select the
check-box for Channel 1, which is where the strain gauge is connected, and then
select the Configure button.

Figure 37 - Node Configuration Menu

3. Use the following settings (Figure 38 - Channel Settings):

a. Conversion Coefficients, Class: A/D value

b. Conversion Coefficients, Units: bits

c. PGA Settings, Hardware Gain: 104

d. PGA Setting:Midscale (for positive and negative going signals)
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4. Select the Auto Balance button to tare the no-load value of the strain gauge. ClickOK
to apply the node settings and exit configuration.

Figure 38 - Channel Settings

5. Right-click on the node heading, and then select Sample > Stream > Start.

Figure 39 - Start Node Streaming
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6. The streaming graph shows the bit output of the channel. 

7. Use a calibrated torque wrench (or some other way of applying and measuring a
known load to the shaft) and apply loads at a number of intervals over the expected
range of use.  At each of the calibration intervals, record the applied force  and the
corresponding sweep value on the y–axis of the graph (the A/D value output of the
sensor).

a. Zoom in and out on the graph by un-checking the Auto Y-Axis Zoom box,
and then right clicking on the graph and selecting Zoom In.  Draw a box
around the desired area to zoom in on.

b. Adjust the Y-AxisWidth from the field next to the Y-Axis Zoom.

c. End sampling by clicking the red X box on the StreamingGraph tab.

Figure 40 - Node Sampling
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8. After making all measurements, calculate a slope from the data using the formula
y=mx+b in a data analysis program, such as Microsoft Excel. See Calculating a
Linear Slope on page 52.

9. Return to the Node Configuration screen for the sensor channel, and select the
Conversion Coefficients Class and Units, and enter the Slope and Offset values
derived in the data analysis program.

Figure 41 - Enter Calibration Values

10. Save the values, and exit configuration.

11. Begin node data streaming again with no load on the sensor.

12. Observe the value in the stream graph. If the stream is not at zero, return to the
channel configurationmenu, and adjust the offset by increasing or decreasing the
value.

13. Once the offset has been zeroed, verify the calibration by applying known loads on
the shaft throughout the load range, observing and verifying the measurement in
engineering units.
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6.3 Calculating a Linear Slope

A data analysis tool such as Microsoft Excel can be used determine the slope of a linear
relationship between sensor output A/D value (bits) and engineering units. This is not a
calibration unless a calibrated reference device is used tomeasure the applied loads.

Here is an example, using Excel:

1. Open a blank spreadsheet.

2. Enter the A/D value (bits) measurements and applied load in the desired engineering
units in two columns. Enter A/D value in the left column (x-axis value) and the applied
load in the right (y-axis value).

3. From the Insert menu, select Chart > Scatter. Select the preferred format.

Figure 42 - Generate a Scatter Chart

4. Right-click on the graphed line, and select Add Trendline .

5. Designate the line as Linear, and check the option to Display the Equation on the
chart (Figure 43 - Plot Trendline).
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Figure 43 - Plot Trendline

6. The formula of the line is y=mx+b, where y is the engineering units at a given point
(measurement),m is the slope of the line that represents the linear ratio, x is the A/D
value at a given point, and b is the fixed zero load offset of the sensor. Enter the slope
and offset as the conversion values for the sensor channel under the applicable
engineering units. In this example, enter 0.1338 for the slope and -282.36 for the
offset for the units conversion values on themeasured channel.

Figure 44 - Slope and Offset Values
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6.4 Theoretical Torque Formula

The theoretical torque formula can be used to convert strain measurements to torque units.
Accuracy is determined by mitigation of error in shaft measurements, shaft uniformity, and
material coefficients.

Figure 45 - Theoretical Torque Formula



Torque-Link™-LXRS® Torque SensorUserManual Maintenance

55

7. Maintenance

The replaceable battery and battery compartment o-ring are the only user serviceable part in the
Torque-Link -LXRS.

For instructions on how to change the battery,see Changing the Batteries on page 56. To order
replacement parts, see Parts and Configurations on page 70

For other service or repair needs contact LORD MicroStrain® Technical Support (see Technical
Support on page 69).
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7.1 Changing the Batteries

The Torque-Link -LXRS contains an internal, non-
rechargeable Lithium battery . For important
precautions see Safety Information on page 80.

1. Remove the battery compartment cover using a T8 Torx (star) driver (Figure 46 -
Battery Installation).

2. Disconnect the battery connecter inside the compartment, and remove the battery

3. Install the new battery in its place, orienting it so the connectors align and the
batterymatches the contour of the compartment.

4. Reinstall the battery compartment cover, ensuring no wires are pinched and the o-
ring seal under the compartment cover is intact.

Figure 46 - Battery Installation
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8. Troubleshooting

8.1 Troubleshooting Guide
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Possible cause and recommended solution

1. POWER

gateway or node does
not turn on

1.1 node or gateway power is off

The status indicator LED on the device may be off.  Turn the
device on, and the status indicator LED should illuminate.

1.2 wrong power supply or voltage

Using a power supply other than the one specified for the device
(or an external supply that is outside of the device operating
range) could result in permanent damage to the device or cause
it to not work properly.

1.3 node battery is dead

If the node will not power on, the node battery may need to be
replaced (see Changing the Batteries on page 56).

1.4 sensors are drawing too much current

The node battery can only supply a limited amount of power to
the connected sensors. If an over-current condition occurs, the
node will shut down. Thismay occur if the sensors are wired
wrong.

1.5 node or gateway is damaged

If all power settings and connections have been verified, and the
node is still unresponsive, contact LORD MicroStrain ®

Technical Support (See Technical Support on page 69).

2. COMMUNICATION

no communication to
the gateway or node

2.1 node or gateway has no power

Verify the node and gateway have power applied and that
applicable power switches are on.  Power is indicated on both
devices by a status indicator LED.

2.2 gateway has no communication with the computer

Verify gateway communication in the software. Check, remove,
and reconnect communications and power cables as applicable. 

l For serial gateways, verify that the COMport setting.

l For USB gateways, verify that the drivers are installed on the
computer (included with Node Commander®) and that the
software has had sufficient time to detect it.
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Possible cause and recommended solution

l For Ethernet gateways, use Live Connect™ to verify
communications on a DHCP network. Check that the
extended timeouts are enabled in the Node Commander®

Edit > Preferencesmenu, under Devices. Once
communication has been established, the network
configuration can be changed.

2.3 node cannot be configured

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling or sleeping, it cannot be configured. In Node
Commander®, execute the Stop Node command to put the
node in idle state, allowing configuration to occur.

If the user inactivity timeout is set very low, the configuration
menuwill have to be entered quickly, before the timeout occurs,
putting the node back in a sample or sleep state.

2.4 node is out of range

Perform a bench test with the node in close proximity to the
gateway to verify they are operational.  For range test and
installation recommendations see Range Test on page 64.  The
system has been tested to operate with the node and gateway
up to 2 km apart with clear line of sight.

2.5 node is not in normal boot mode

If the node status indicator shows the node booting in a mode
other than the normal boot mode, it can be bypassed by cycling
the node power rapidly three times, then leaving it on for normal
power up. In normal boot mode the communication can be
established with automatic node discovery (or manually) once
the boot process is complete and the node is in idle state. Start-
upmode can then be changed in the software.

2.6 node is sampling

Observe the node status indicator LED to determine the
device's state: boot, idle, active, or sleep. If the node is
sampling, it cannot be configured. In Node Commander® ,
execute the Stop Node command to put the node in idle state,
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Possible cause and recommended solution

allowing configuration to occur.

2.7 node is sleeping

Observe the node status indicator LED to determine what state
it is: boot, idle, active, or sleep. If the node is sleeping, it cannot
be configured. In Node Commander®, execute the Stop Node
command to put the node in idle state, allowing configuration to
occur.

2.8 gateway or node is damaged

Verify all connections, power, and settings.  If available, try
installing alternate nodes and gateways one at a time to see if
the faulty device can be identified.  If no conclusion can be
determined or to send a device in for repair, contact LORD
MicroStrain® Technical Support (See Technical Support on
page 69).

3. DATA ACQUISITION

sensor data is missing
or incorrect

3.1 no communication to node or gateway

Verify connections and power to the node and gateway. Verify
they are powered on and communicating with the software.
Enter a configurationmenu to verify that the node can be
accessed.

3.2 sampling settings are incorrect

If the sampling mode, rate, or duration are not performing as
expected, enter the node configuration menu, and verify the
sampling settings.

3.3 sampling has not started

If sampling is occurring, the sampling mode will be displayed
next to the node name in Node Commander®. The node device
status indicator will also be flashing the sampling mode code. If
the node is not sampling, activate it in the software or with a
sample on start up boot sequence.

3.4 sensor is not connected correctly

Verify sensors connections and wiring.  For non- standard
connections contact LORD MicroStrain® Technical Support
(See Technical Support on page 69).
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Possible cause and recommended solution

3.5 sensor channel not configured correctly

Verify that the sensor is configured on the correct channel and
has been enabled for data acquisition. 

3.6 sensor calibration is invalid

If possible, perform a field verification of the sensors by applying
known loads and comparing the measured values.  In the
channel configuration settings, verify that the calibration
calculations are correct.   Verify that the gain and offset range
are correct and that the baseline offset is set with Auto Balance,
as applicable.   Verify that the calibration values (slope and
offset) are correctvalue (slope and offset) is correct. Verify that
the sensor channel units are selected correctly.  Verify that all
parameters were written to the node channel. Recalibrate as
needed.
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8.2 Device Status Indicators

The following is a complete summary of the Torque-Link -LXRS status indicators.

Indicator Behavior Node Status

Device Status
Indicator

OFF Node isOFF or sleeping

OFF, with occasional flash
Node is sleeping with radio check
intervals enabled (default is every
5 seconds)

Ten rapid flashes green when
power is initially applied

Node is booting normally and
sending out a statusmessage.

1 second pulse green Node is idle
ContinuouslyON green Node is datalogging

1 Hz pulse green
Node is sampling in low duty cycle
or synchronized samplingmode

ON bright green
Node is in synchronized sampling
mode and is re-syncing or taking a
burst sample

Pulses for each ping

Node is sending out
communication requests (such as
in ping command, range test, or
EEPROM read/write)

Four to seven slow pulses
when power is initially applied

Fault condition

Table 3 - Device Status Indicators
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8.3 Optimizing the Radio Link

In ideal conditions, the nodes and gateway can communicate up to 100 m apart.  In order to
accomplish this, the node and gateway must be installed in a manner that optimizes the
wireless transmission.  The Torque- Link™ - LXRS ® operates at a 2.4GHz transmission
frequency. The internal antenna has an omni-directional radiation pattern.  Using any other
antenna with the node will void FCC compliance.

The best method for ensuring optimal radio communication is to conduct an RF survey of the
installation site. This is easily accomplished in Node Commander® by using the range test
feature to quantify the radio signal strength (RSSI) in various scenarios. See Range Test on
page 64 for instructions on using Node Commander® for measuring RSSI. The following are
general guidelines for maximizing transmission range:

l Establish Line of Sight (LOS) between the node and gateway antennaas best
as possible.  Try to avoid obstructions between the antennae, such as buildings,
terrain, vegetation, or other physical barriers.  Increase the mounting height of the
nodeto allow a clearer LOS path to the gateway.  Height above the ground is also
important because reflections off of the ground can interfere at the receiver.
Generally, the higher above the ground the better.

l Minimize Radio Frequency Interference (RFI) such as other equipment
antennae, especially those operating in the same frequency range.  This includes
other nodes.  If other antennae are required nearby, mount them at different
heights to minimize interference. Additionally, the specific node frequency is
selectable within its operational range using theNode Commander® software. Set
the devices to different transmission frequencies.

l Minimize Electromagnetic Interference (EMI) such as that which is generated
by power transmission equipment, microwaves, power supplies, and other
electromagnetic sources.

l Metal Objects in close proximity to either antenna, particularly ferrous metals
such as steel and iron, can be problematic for wireless communications.  The
larger the object, the greater the influence. 
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8.3.1 Range Test

After establishing communication between node and gateway, use the range test feature in
Node Commander® to monitor the signal strength and to optimally position the nodes,
gateway, and antennae for installation. Maximum achievable range is determined by the
gateway and node power settings (found in the device Configure menu) and is highly
dependent on the physical environment surrounding the devices.

1. Right-click on the node header, and select Communicate > Range Test.

Figure 47 - Range Test Menu

2. The total RSSI range for the node and gateway is -90 to 0dBm. The higher the
value(closer to zero), the better, but reliable communication can be achieved
between -75 dBm and 0 dBm. The devices is still able to communicate between -
90 dBmand -75 dBm, but it could be intermittent or result in data loss. Position the
node and gateway antennaswhere the best RSSI value is observed.

Figure 48 - Range Test Statistics
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8.4 Battery Connector

The batteries come with the connecter installed, but if voltage measurement is needed for
troubleshooting or otherwise, refer to Table 4 - BatteryWiring.

Battery terminal Signal Wire color Connector pin
Battery + V+ red 3

Battery - GND black 1

Table 4 - Battery Wiring
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8.5 Updating Node Firmware

Under the recommendation of LORD MicroStrain® Technical Support Engineers, nodes can
be upgraded to the latest available firmware to take advantage of new features or correct
operating issues.  Node Commander® version 2.7.0 or greater can be used to update any
mXRS® or LXRS® node or gateway firmware to the most current version.  Updates are found
on the LORD MicroStrain® website.  See Technical Support on page 69 for contact and
website information.

1. Download the LXRS® Firmware Upgrade file from the LORD MicroStrain®website.

2. Once downloaded, extract the contents of the .zip file into a folder on the computer. 
Verify there is a file with a .zhex extension.

3. Launch Node Commander® , and establish communication between the node and
gateway as normal.

4. While holding F1 on the keyboard, right-click the node name, and a drop-downmenu
will appear.

Figure 49 - Update Node Firmware
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5. Release the F1 key.

6. Click Upgrade Firmware, and the Node Firmware Upgrade window will appear.

7. Click Browse, and navigate to the downloaded .zhex file.

8. Click Write, and the upgrade sequence will begin.  When completed, "Upgrade
Success" will appear in the Status column.

Figure 50 - Upgrade Firmware Window
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8.6 Repair and Calibration

General Instructions

In order to return any LORD MicroStrain® product, you must contact LORD
MicroStrain® Sales or Technical Support to obtain a Return Merchandise
Authorization number (RMA). All returnedmerchandisemust be in the original
packaging including manuals, accessories, cables, etc. with the RMA number
clearly printed on the outside of the package.  Removable batteries should be
removed and packaged in separate protective wrapping.  Please provide the
LORD MicroStrain® model number and serial number as well as your name,
organization, shipping address, telephone number, and email.  Normal turn-
around for RMA items is seven days from receipt of item by LORD
MicroStrain®.

Warranty Repairs

LORD MicroStrain® warrants its products to be free from defective material
and workmanship for a period of one (1) year from the original date of
purchase. LORD MicroStrain® will repair or replace, at its discretion, a
defective product if returned to LORD MicroStrain®within the warranty period.
This warranty does not extend to any LORD MicroStrain® products which have
been subject to misuse, alteration, neglect, accident, incorrect wiring, mis-
programming, or use in violation of operating instructions furnished by us. It
also does not extend to any units altered or repaired for warranty defect by
anyone other than LORD MicroStrain®.

Non-Warranty Repairs

All non-warranty repairs/replacements include a minimum charge. If the
repair/replacement charge exceeds the minimum, LORD MicroStrain® will
contact the customer for approval to proceed beyond theminimumwith the
repair/replacement.
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8.7 Technical Support

There are many resources for product support found on the LORD MicroStrain® website,
including technical notes, FAQs, and product manuals.

http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support

sensing_support@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

SKYPE:microstrain.wireless.support

Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_support@LORD.com
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9. Parts and Configurations

9.1 Standard Configurations

The Torque-Link -LXRS is available in standard sizes based on the shaft size it will be installed
on. It is also available with one or two channels for attaching strain gauges. For example part
numbers, seeTable 5 - Example Torque-Link™-LXRS® Part Numbers.

Figure 51 - Part Number Designations
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Description
LORD MicroStrain®

Part Number
Torque-Link™-LXRS®with non-recharagble battery, 2.05"
outer diameter, and one sensor channel

6330-2051

Torque-Link™-LXRS®with recharagble battery, 6.55" outer
diameter, and two sensor channels

6331-6552

Table 5 - Example Torque-Link™-LXRS® Part Numbers

9.2 Replaceable Parts

Description
LORD MicroStrain®

Part Number
Non-rechargeable Lithium battery assembly 3053-0003
Strain gauge connector harness 9008-0397
Collar screw - socket head capscrew 8-32 x 5/8" 9100-0192
Battery compartment screw - button head Torx 4-40 x 5/16" 9100-0247
Battery compartment o-ring - Buna-N size 037 9117-0028
Collar placement tape - 3MVBH 9203-0008

9.3 Recommended Strain Gauges

Description Manufacturer and
Part Number

Dual-element shear/torque pattern strain gauge Vishay 062UV series

Strain gauge terminal strip for wiring
Vishay MM Bondable
Terminals CPF series



Torque-Link™-LXRS® Torque SensorUserManual Parts and Configurations

72

9.4 Wireless System Equipment

Model Description
LORD

MicroStrain®

Part Number
WSDA-1500-SK Ethernet Data GatewayStarter Kit 6314-1501

-- Node Commander® Software 6301-0300

--
SensorCloud™ Software Subscription
(contact LORD MicroStrain® Sales)

--

WSDA-BASE-104-SK USB GatewayStarter Kit 6307-1041
WSDA-BASE-102-SK RS232GatewayStarter Kit. 6307-1021
WSDA-BASE-101-SK AnalogGatewayStarter Kit 6307-1011

-- Replacement USB cable 9022-0029
-- USB Gateway cable extender 6307-0900
-- Replacement serial cable 4005-0005

WSDA-1500 Ethernet Data Gateway 6314-1500
WSDA-BASE-104 USB Gateway 6307-1040
WSDA-BASE-102 RS232 Serial Output Gateway 6307-1020
WSDA-BASE-101 AnalogOutput Gateway 6307-1010
G-Link-LXRS Wireless Accelerometer Node various models
G-Link2-LXRS Wireless Accelerometer Node various models
SG-Link-LXRS Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-OEM Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-RGD RuggedizedWireless Analog Sensor Input Node various models
V-Link-LXRS Wireless 7-Channel Analog Input Sensor Node various models
TC-Link-LXRS Wireless Thermocouple Node various models
DVRT-Link-LXRS WirelessDisplacement Sensor Node various models
ENV-Link-Pro Wireless Environmental Sensor Node various models
Watt-Link-LXRS Wireless EnergyMonitoring Sensor Node various models
RTD-Link-LXRS WirelessRTD Sensor Node various models
IEPE-Link -LXRS Wireless IEPE Accelerometer Node various models

Table 6 -Wireless System Equipment
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9.5 Product Ordering

Products can be ordered directly from the LORD MicroStrain® website by navigating to the
product page and using the Buy feature. 

http://www.microstrain.com/wireless

For further assistance, our sales team is available to help with product selection, ordering
options, and questions.

Sales Support

sensing_sales@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_sales@LORD.com
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10. Specifications

10.1 Physical Specifications

The Torque-Link -LXRS is available in many sizes to fit a variety of standard shaft diameters
(see Parts and Configurations on page 70). All variations are the same height.

Figure 52 - Torque-Link™-LXRS® Dimensions
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10.2 Operating Specifications

Parameter Specifications
General

Sensor input channels Differential analog, 1 channel (standard),
2 channels (optional)

Integrated sensors Internal temperature, 1 channel

Options

Half and 1/4 bridge, 350Ω or 1000Ω completion on any or all
channels, custom gain, custom anti-aliasing filter, extended
operating temperature, g-force, and environmental packaging,
low RF radiated power

Data storage capacity 2M bytes (up to data points)

Analog Input Channels

Measurement range Differential: full-bridge, ≥ 350Ω
Accuracy ±0.1% full scale typical

Resolution 16 bit

Anti-aliasing filter bandwidth Single-pole Butterworth
-3 dB cutoff @ 500 Hz

Bridge excitation voltage +3 V dc
(pulsed@sample rates ≤16 Hz to conserve power)

Measurement gain and offset User-selectable in software, gain values from 20 to 2560

Integrated Temperature Channel

Measurement range -40 °C to 85 °C, ± 2 °C (at 25 °C) typical

Resolution 12 bit

Sampling

Sampling modes Synchronized, low duty cycle, datalogging

Sampling rates
Continuous sampling: 1 sample/hour to 512 Hz
Periodic burst sampling: 32 Hz to 4096 Hz
Datalogging: 32 Hz to 4096 Hz

Sample rate stability ±3 ppm

Network capacity

Up to 2000 nodes per RF channel (and per gateway) depending
on the number of active channels and sampling settings.
Refer to the system bandwidth calculator:
http://www.microstrain.com/configure-your-system

Synchronization between nodes ±32 µsec

Event driven monitoring
User-definable threshold trigger (synchronized and low duty
cycle modes), 200K bytes pre- event recording

Operating Parameters

Wireless communication range 100m (typical)

Radio frequency (RF)
transceiver carrier

2.405 to 2.470GHz direct sequence spread spectrum over 14
channels, license free worldwide, radiated power programmable
from 0 dBm (1mW) to 16 dBm (39mW); low power option
available for use outside the U.S.- limited to 10dBm (10mW)

RF communication protocol IEEE 802.15.4

RF data downloading 4.5minutes to download full memory

Power source
Replaceable, non-rechargable battery pack (3.0 V dc, 1.2 Ah
Li/MnO2 batteries in series configuration)

Power consumption 1 to 25mA (configuration dependent, see user manual)

Operating temperature -20 ˚C to + 80 ˚C

Angular acceleration limit 500 g standard (high g option available)

Maximum RPM
2500 to 4200 RPM (diameter dependent, see user manual, high
RPM option available)

Physical Specifications

Dimensions
Height 88.9mm (3.5 inches), ID varies for use on 50.8 to 152.4
mm (2 to 6 inch) diameter shafts (custom sizes available)76
mm x 137mm x 47mm

Weight 500 grams (without battery)200 to 525 grams (0.44 to 1.16 lb),

http://www.microstrain.com/configure-your-system
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Parameter Specifications
depending on size

Environmental rating
IP 66, tested to DO-160 standards for temperature variation,
humidity, and vibration

Enclosure material ABS thermoplastic

Integration

Compatible gateways All WSDA® base stations and gateways

Compatible sensors Bridge type analog sensors

Connectors Strain guage and battery interface connectors

Shunt calibration Internal shunt calibration resistor 499 KΩ1.499MΩ
Software SensorCloud™, Node Commander®, Windows XP/Vista/7

Software development kit (SDK)

Open-sourceMicroStrain Communications Library (MSCL) with
sample code available in C++, Python, and .NET formats
(OS and computing platform independent)
http://lord-microstrain.github.io/MSCL/

Regulatory compliance FCC (U.S.), IC (Canada), ROHS

http://sensorcloud.com/mathengine
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10.3 Torque-Link RPM Limits

Themaximum g-force that can be applied to the Torque-Link -LXRS is 500g. Depending on the
size of the Torque-Link -LXRS , there is a corresponding limit on the rotational speed
(revolutions per minute - RPM) that will produce that g- force.

Figure 53 - Maximum Rotation Speed
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10.4 Power Profile

Node power use is highly dependent on the operational parameters such as sample mode and
rate. More active channels and higher sample rates equate to increased power use. Below is
an example approximation of the power profile of a Torque-Link -LXRS over a range of sample
rates operating in Synchronized Samplingmode. 

Figure 54 - Example Torque-Link™-LXRS® Power Profile
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10.5 Radio Specifications

The Torque-Link -LXRS employs a 2.4GHz IEEE 802.15.4-compliant radio transceiver for
wireless communication.  The radio is a direct-sequence spread spectrum radio and can be
configured to operate on 14 separate frequencies ranging from 2.405 GHz to 2.470 GHz. 
Following the 802.15.4 standard, these frequencies are aliased as channels 11 through 24. 
For all newlymanufactured nodes, the default setting is 2.425GHz (channel 15). 

The radio complies with FCC Part 15 (USA) and IC (Canada) regulations. The radio is license-
free worldwide.  Using antennas and transmission equipment other than what is providedmay
void FCC compliance.

NOTE

l The gateway can automatically manage nodes operating on different frequencies
by using the Node Discovery feature in Node Commander®. In this routine, the
gateway listens for node broadcasts on the frequency channel to which it is set. If
the node is in normal boot-up mode, it will provide the broadcast when it is initially
powered-on, and it will broadcast on all channels. As long as the node is powered-
on after activating the Node Discovery feature, the gateway will link to it and
remember the channel setting for future node queries.

l Manually matching the node and gateway frequency channels is required in some
applications. For example, when sending broadcast messages from the gateway to
multiple nodes (including the synchronized sampling beacon) all nodes must be on
the same channel as the gateway in order to receive the broadcast. Assigning
channels is also a good idea when multiple gateways are attached to one host
computer or when other wireless equipment is nearby and frequency or
transmission interferencemay occur.
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11. Safety Information

This section provides a summary of general safety precautions that must be understood and
applied during operation and maintenance of components in the LORD MicroStrain® Wireless
Sensor Network.

11.1 Battery Hazards

The Torque-Link™ - LXRS ® Torque Sensor contains an
internal, non- rechargeable Lithium Magnesium Dioxide
(Li/MnO2 ) battery pack.  Li/MnO2 batteries are a fire and
explosion hazard.  Do not store or operate the node at
temperatures above 212°F (100°C).  Do not disassemble,
short circuit, crush, puncture, or otherwise misuse the
battery. Do not attempt to recharge the batteries.  Do not
expose the batteries to water. 

When replacing batteries, use only the batteries specified for
the node (see Parts and Configurations on page 70). Follow
the battery installation instructions, observing polarity and
battery orientation and taking care not to short circuit the
battery terminals (see Changing the Batteries on page 56).

Li/MnO2 batteries contain toxic chemicals that are harmful to
humans and the environment.  Disposal is subject to federal
and local laws.  Do not discard the battery or the node in the
trash.  Follow proper battery disposal protocol, or contact
LORD MicroStrain® Technical Support for information on
extracting the battery or returning the product for proper
recycling and disposal.
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11.2 Disposal and Recycling

The Torque-Link™-LXRS® contains internal batteries,
printed circuit boards, and electronic
components. These items are known to contain toxic
chemicals and heavy metals that are harmful to humans
health and the environment.  Disposal is subject to
federal and local laws.  Do not discard the device or
batteries in the trash.  Follow proper electronic and
battery waste disposal protocol, as dictated by federal
and local authorities. Some states have programs for
extracting reusable parts for recycling.
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12. References

12.1 Reference Information

Many references are available on the LORD MicroStrain® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated,
and new applications are added. They may provide more accurate information than printed or
file copies. 

Document Where to find it

Online Wireless Network Calculator
http://www.microstrain.com/configure-your-

system
Node Commander® Software User

Manual
http://www.microstrain.com/support/docs

SensorCloud™
Overview

http://www.sensorcloud.com/system-
overview

MathEngine® Overview http://www.sensorcloud.com/mathengine
LORD MicroStrain®Wireless Sensors
Network Software Development Kit

http://www.microstrain.com/wireless/sdk

Product Datasheets http://www.microstrain.com/wireless/sensors
Product Manuals and Technical Notes http://www.microstrain.com/support/docs

Product Application Notes http://www.microstrain.com/applications
NIST Calibration Procedures http://www.nist.gov/calibrations/

ASTM Testing Procedures
http://www.astm.org/Standard/standards-

and-publications.html
ASTM Strain Gauge Installation Guide

ASTM E1237-93
http://www.astm.org/Standards/E1237.htm

Table 7 - Related Documents

http://sensorcloud.com/pricing?showCalculator=true
http://sensorcloud.com/pricing?showCalculator=true
http://www.microstrain.com/support/docs
http://www.sensorcloud.com/system-overview
http://www.sensorcloud.com/system-overview
http://www.sensorcloud.com/mathengine
http://www.microstrain.com/wireless/sdk
http://www.microstrain.com/wireless/sensors
http://www.microstrain.com/support/docs
http://www.microstrain.com/applications
http://www.nist.gov/calibrations/
http://www.astm.org/Standard/standards-and-publications.html
http://www.astm.org/Standard/standards-and-publications.html
http://www.astm.org/Standards/E1237.htm
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12.2 Glossary

These terms are in common use throughout themanual:

A/D Value: the digital representation of the analog voltages in an analog- to- digital (A/D)
conversion. The accuracy of the conversion is dependent on the resolution of the system
electronics; higher resolution produces amore accurate conversion. Also referred to as "bits".

Base Station: The base station is the transceiver that attaches to the host computer and
provides communication between the software and the node(s). It is also referred to as a
gateway.

Burst Sampling: amode of operation in which the node is sampled for a fixed window of time
(burst) and then repeats that window at set intervals. The burst duration and time between
bursts is configurable. Also referred to as periodic burst sampling.

Calibration: to standardize a measurement by determining the deviation standard and
applying a correction (or calibration) factor

Configuration: a general term applied to the node indicating how it is set up for data
acquisition.  It includes settings such as sampling mode/rate, number of active channels,
channel measurement settings, offsets, hardware gain, and calibration values. 

Continuous Sampling: a mode of operation in which the node is sampled continuously until
stopped or sampled continuously for a fixed amount of time

Coordinated Universal Time (UTC): the primary time standard for world clocks and time. It
is similar to GreenwichMean Time (GMT).

Cycle Power: a command transmitted to the node to reboot it either through a hardware or
software switch

Data Acquisition: the process of collecting data from sensors and other devices

Data Logging: the process of saving acquired data to the system memory, either locally on
the node or remotely on the host computer

DHCP (network): Dynamic Host Configuration Protocol is the standardized networking
protocol used on Internet Protocol (IP) networks, which automatically configures devices that
are attached to it by assigning and configuring the device IP address.
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EMI: Electromagnetic Interference is an inductive or radiated disturbance that can create
signal degradation on electrical signals, including loss of data.

ESD: Electrostatic Discharge is the sudden flow of electricity that can occur between two
charged objects of different potential that come in contact or in close proximity of each other.
Static electricity is a common source of ESD.

Event-Based Sampling: a mode of operation in which the node sampling is started when a
sensor measurement value (threshold) is achieved

Firmware: the code that is programmed onto a microcontroller or similar device in an
embedded system. It includes device operation commands, conditions, memory allocation, and
many other tasks. 

Gateway: The gateway is a transceiver that attaches to the host computer and provides
communication between the software and the node(s). It is also known as a base station.

Host (computer): The host computer is the computer that orchestrates command and control
of the attached devices or networks.

LED: Light Emitting Diode is an indicator light that is used in electronic equipment.

LOS (Line of Sight): is used in radio communications to describe the ideal condition between
transmitting and receiving antennas in a radio network.  As stated it means the antennae are in
view of each other with no obstructions.

LXRS®:Lossless Extended Range Synchronized is the proprietary LORD MicroStrain® data
communications protocol used in the wireless sensor network.

Node: The node is the wireless transceiver to which the sensor(s) is connected, providing
communication with the gateway.  The G-Link® -LXRS®, V-Link® -LXRS®, and SG-Link® -
LXRS® are examples of nodesmanufactured by LORD MicroStrain®.

Node Tester Board: The node tester board is a device designed by LORD MicroStrain® that
can be plugged into nodes to test their functionality.

Offset: When describing amathematically-linear relationship, the offset is the value where the
line that represents the relationship in a graph crosses the y-axis.  The equation of a straight
line is: y = mx+b, where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope and
b is the offset.
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Oversampling: In signal processing, oversampling is a technique used to achieve increased
signal resolution and better noise immunity by recording readings at a higher frequency than
the output of the device being measured. In analog- to- digital conversion, the higher the
oversampling rate, the better the recreated analog signal.

Packet: unit of sampled data

Periodic Burst Sampling: a mode of operation in which the node is sampled for a fixed
window of time (burst) and then repeats that window at set intervals. The burst duration and
time between bursts is configurable. Also referred to as burst sampling.

Ping: a byte transmitted by the gateway to the node. The node responds by echoing the byte,
indicating communication exists between the node and gateway.

Range Test: a continuous string of pings used to validate communication between the
gateway and the node over distance and obstruction

Real Time Clock (RTC): a computer clock that keeps track of the current time

RFI: Radio Frequency Interference is a disturbance in an electrical circuit due to
electromagnetic induction or radiation.

RSSI: Received Signal Strength Indication is a measurement of the transmission power in a
radio signal. It ismeasured in decibels with reference to 1milliWatt (dBm).

RS232: a serial data communications protocol

Sensor: a device that physically or chemically reacts to environmental forces and conditions,
producing a predictable electrical signal

Sleep: a command transmitted to the node to put it into sleep configuration

Sampling: the process of takingmeasurements from a sensor or device

Sampling Mode: the type of sampling that is being utilized, such as event- triggered,
continuous, or periodic. The nodes have several samplingmodes that employ these types of
sampling.

Sampling Rate: the frequency of sampling
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Slope:When describing amathematically linear relationship, the slope is the steepness of the
line that represents that relationship on a graph.  The equation of a straight line is: y = mx+b,
where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope, and b is the offset.

Streaming: Streaming is a sampling mode in which all active channels (and the sensors
attached to them) are measured, and the acquired data is transmitted to the gateway and
software. The data is not written to non- volatile memory during streaming.  Streaming can
either be finite (have a user defined start and end time) or continuous (continued until the power
is cycled on the node).

Synchronized Sampling: a sampling mode that automatically coordinates all incoming node
data to a particular gateway. Thismode is designed to ensure data arrival and sequence.

Transmission rate: the number of data packets per transmission window, measured in
seconds. Depending on the samplingmode and settings it will be between 1 and 64
packets/second.

Transmission window: the time allowed for one data transmission at the automatically
determined transmission rate

USB:Universal Serial Bus is a serial data communications protocol

WSN: Wireless Sensor Network describes a distribution of sensors and data acquisition
equipment that autonomously monitors environmental characteristics, such as temperature,
pressure, and strain.
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